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1. Introduction  

1.1. About Fuse Creator Ê 

Fuse Creator Ê is an intuitive activity -creation tool that is quick and easy to use, requires little  

technical knowledge, and  can help you produce professional -looking activities and resources in 

minutes . 

 

With Fuse Creator Ê you can:  

Create  ð set up and create a whole range of new interactive activities from scratch  

Edit  ð open and edit existing activities to tailor them to your needs  

Sequence  ð add branching to an activity so it can be differentiated for all ability levels  

Publish  ð publish activities in a number of different formats at the click of the mouse  

 

You may wish to use Fuse Creator Ê to create quick activities for your lessons on an ad-hoc basis, or 

yo u could use it to make more in -depth assessments or exercises that will personalize the learning 

experience of all your students. Fuse Creator can even be used by students to show that they have 

grasped a particular learning objective enough to teach it to  their peers or other learners.  

 

This User Guide describes all of the features available in the Standard Edition of Fuse Creator.  In the 

Demo Edition, the following features are unavailable:  

-          Save 

-          Save Asé 

-          Import SCORMé 

-          Export SCORMé 

-          Publish Standaloneé 

  

If you would like to purchase the Standard Edition, please visit http://www.rmeducation.com  

1.2. How to use this guide  

This guide comprises the following sections:  

 

Installing Fuse Creator  ð describes how to install the software onto your computer.  

Guided tour  ð provides a brief overview of all the features of Fuse Creator . 

Using Creator to create and edit activities  ð provides guidance on using Fuse Creator  to crea te and 

edit activities including details about page types.  

Using Creator  to sequence activities ð provides guidance on using Fuse Creator  to sequence 

existing pages in an activity , including scoring and feedback.  

Playing your Fuse activities  ð an overview of the playback features available in Fuse Creator . 

Saving your activities ð guidance on saving the activities you have created using Fuse Creator  

Using Creator to publish activities  ð an overview of publishing options available in Fuse Creator . 

1.3. Getting support  

If you experience  problems using Fuse Creator Ê: 

 

- Visit www.rmeducation.com/rmsupport , mail support@rmeducation.com , or  

- Contact RM Support at 866 -728-6758 during office hours  (Monday ðFriday, 8:30am ð5pm EST). 

http://www.rmeducation.com/
http://www.rmeducation.com/rmsupport
mailto:support@rmeducation.com
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2. Installing Fuse CreatorÊ 

This section details the  hardware and software you will need before you start to use Fuse Creator Ê.   

2.1. Technical requirements  

The table below shows the recommended har dware and software required to use Fuse Creator Ê 

to create activities:  

 

Operating System  Standalone computers using 

Windows® 2000, Windows® XP 

SP2/3 & Windows VistaÊ and 

Windows Server® 2003 with client 

computers using Windows® XP 

SP2/3 or Windows VistaÊ 

OS X 10.5.7, 

OS X 10.4.11 

Processor  1GHz+  G4 800MHz+ 

Memory  512MB  512MB 

Storage  100MB 100MB 

Screen  1024x768 1024x768 

 

 

The table below shows the recommended hardware and software needed to run published 

activities (Fuse Creator Ê is not required)-: 

 

 Microsoft® Windows®  Apple Macintosh  RM Minibook  

Operating System  Standalone computers 

using Windows ® 2000, 

Windows® XP SP2 & 

Windows VistaÊ  and 

Windows Server® 2003 

with client computers 

using Windows®XP SP2 

or Windows VistaÊ 

OS X 10.5.1, 

OS X 10.4.10 

Xandros Ê/Windows ® 

XP 

Processor  800Mhz+  G4 800MHz+ 900MHz 

Memory  256MB  256MB+ 256MB 

Screen  800x600 800x600 800x400 

Flash Player  Adobe® Flash® Player 

8+ 

Adobe® Flash® 

Player 8+  

Adobe® Flash® 

Player 8+  

Browser Microsoft® Internet 

Explorer® 5.5/6.0/7.0, 

Mozilla® Firefox ®2/3,  

Opera 9  

Apple Safari 1.2,  

Mozilla® Firefox®2,  

Opera 9  

Mozilla® Firefox® / 

Microsoft® Internet 

Explorer® 

 

 

Note:  Restricted Mac users are not supported . 
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2.2. Installing Fuse Creator Ê on your computer  

The following steps guide you th rough the process of installing Fuse Creator Ê. 

 

To install to your Windows® -based or Macintosh -based computer follow the on -screen instructions.  

 

1. Insert the Fuse Creator Ê disc into your computer drive. 

2.  

a)  For Windows® users; the installation wizard should start automatically.  If installation does 

not start automatically, locate and select the setup program on the disc and double -click 

to run.  Click Standalone Computer . 

b)  For Macintosh users; locate and select the setup application on the disc and double -click 

to run.  

3. Follow the installation wizard by choosing the Next  button when prompted.  

4. You will be prompted to accept the terms of the license agreement. Choose ôI accept éõ and 

click Next . 

 

Note:  Your establishment name must consist of at least four charac ters and will be used when 

you publish activities.  

               You must enter the product key at this time otherwise Fuse Creator Ê will be installed as a 

demonstration version which does not support saving and exporting activities.  

 

 

5. Enter your establi shment name  and the product key  which can be found on the Fuse Creator Ê 

package and click Next . 

6. Choose the location on your computer where you want Fuse Creator Ê to be installed and click 

Next.  

7. Click Next  to have the media files and sample activities ins tall to the default  location. This is 

C:\ Program files for PC and Mac: \ Applications for Mac.  

 

Note: You can click Back , (Windows®) or Previous (Macintosh) to review and/or change the settings 

on each screen . 

 

 

8. When you have finalised all options, click Install  to continue.  

9. Mac intosh users will see a òChoose Alias Folderó screen providing the following  options : In the 

Dock, On the Desktop, In your home folder, Other and Donõt create aliases. Select an option 

and click Next . 

10. Fuse Creator Ê will install the necessary files to your computer.  When the installation is complete 

click Finish. 

 

 To run Fuse CreatorÊ click on the Fuse Creator icon  on the desktop or other chosen 

location.  
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3. Guided tour  

3.1. Start Page  

When you first open Fuse Creator Ê, the Start Page  display s. This gives you three  options:  

Create  a new activity, Edit an existing activity or Run an activity.   

3.2. Activity Set -Up page  

When you choose  the Create  option,  the Activity Set -Up page displays. This allows you to defin e the 

activity and some of its parameters.  Enter as much information as you can . This will help with 

tagging the activity later on.   

3.3. Creating Pages  

When you are starting a new activity from scratch, you will see a page  showing a  panel  Select the 

first pag e type . 

 

 
 

There are now nine  page types available:  

¶ Drag and Drop  

¶ Ordering  

¶ Fill the Gap  

¶ Question  

¶ Linking Lines 

¶ Flashcards  

¶ Information  

¶ Menu Page  

¶ Sorting 

 

 

 

 

 

 

 

 

 

 

 



 

You can create as many pages as you like by clicking the New  button.  Your pages will  

be added to the page tray at the bottom of the page . A collection of pages  is 

referred to as an activity .  

 

 

3.4. Sequenc ing activities  

Once you have created the  pages  of your activity , you can sequence them and 

add branching to  them  so that different users  get a different experience 

depending on their score.   You can  add comments to a page outcome , 

dependent on the score achieved, and you can also add a final report page t o 

the activity to show users  how they did in the activity . 

3.5. Previewing your work  

You ca n preview both your pages and your sequenced activities. The Preview Page  

button  in the page editor will allow you to test the current page.   

 

 

 

The Run Activity  button  in Sequencer will allow you to test the fully sequenced  

activity.  You will see the p age or  activity exactly as the intended user will see it .   

 

 

3.6. Running your activity  

The Playback  screen will allow you  to run the activity as a  user will see it .  It will display all the 

functionality that  you have defined for the activity including a spla sh screen  with copyright 

message, prompt for user name  and report pages .  

3.7. Saving your work  

You can save your activity as an editable Fuse Creator Ê file to come back to later. You can also 

Save As , in order to create different versions with slightly differ ent content or structure by changing 

the file name . 

3.8. Publishing  

You can publish Fuse Creator Ê activities in the following ways : 

 

Publish Standalone  ð this feature allows you to publish the current activity as an . html  or .swf file to be 

played back on a co mputer or via a website.  

Export SCORM  ð this feature allows you to publish the current activity as a SCORM pack for use in a 

VLE. 
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3.9. File Menu  

The File Menu  on the main navigation bar at the top of the Fuse CreatorÊ 

window provides  the following options : 

 

Create New é ð allows you to c reate a new activity . 

Open Activity éð allows you to o pen an existing activity . 

Sample Activities é ð allows direct access to the sample files provided.  

Save  ð allows you to s ave the current activity . 

Save Asé ð allows you to s ave  the current activity under a different file name.  

Import  SCORMé ð allows import of SCORM files produced in Fuse Creator.  

Export SCORMé ð allows you to publish the current activity in either SCORM 1.2 or SCORM 2004 

formats.  

Publish Standalone é ð allows you  to p ublish the current activity as a standalone activity, which can 

be copied to other computers.  

Activity Set -Upé ð allows you to add some basic and advanced details to describe the activity . 

Exit ð allows you to e xit the application . 

3.10. Edit Menu  

The Edit Menu on the main navigation bar at the top of the Fuse Creator Ê window provides the 

following options : 

 

Undo  ð allows you to undo the last action  

Redo  ð allows you to redo the last action you undid  

Cut  Object  ð allows you to cut the selected item or text  to the clipboard  

Copy  Object  ð allows you to copy the selected item or text to the 

clipboard  

Paste Object  ð allows you to paste the selected item or text from the 

clipboard to the page  

Paste Object  in Place  ð allows you to paste an item in the same place that 

you copied it from. This means that you can copy an object from one 

page and paste it in the same place on a different page.  

 

3.11. Help Menu  

The Help Menu  on the main navigation bar at the top of the Fuse Creator  Ê 

window provides the following options . 

 

Help  ð opens the help file which covers the features of Fuse Creator Ê and includes a quick tutorial. 

User Guide  ð opens a copy of this guide which you can print out.  

Creator  Web site  ð allows you to open the Fuse Creator  Ê web site. 

About Creatoré ð allows you to view detailed product information such as copyright, version and 

product type. There are also links to product and company Web sites and a link to the License 

Agreement for Fuse Creator Ê. 
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4. Using Creator t o c reat e and edit activities  

4.1. Start Page  

The Start Page  when active displays every time you run Fuse Creator Ê.   

 

 

 
 

This page provides a quick route to the main features of Fuse Creator Ê:  

 

To create a new activity, click  Create . The Activity Set -Up po p-up displays .  

 

If you want to edit an existing activity, click Edit then browse to the location of the activity on your 

computer and click Open . 

 

If you want to run an existing activity, click Run then browse to the location of your sequenced 

activity on  your computer and click Open.  
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4.2. Activity Set -Up  

This pop -up  allows you to define  the activity you want to create. The information you provide here 

will help when it comes to tagging and publishing the activity later on.   

4.2.1. Basic Set-Up 

 

There are two fiel ds that must be filled in -Title 

and Description .  

Type the information into the associated text 

boxes.  

 

 

 

 

 

 

 

 

 

 

4.2.2. Advanced  Set-Up 

This set-up page  contains s ix optional fields : 

 

Keywords:  type some  keywords  here  to  aid 

discovery of the activity within a V irtual 

Learning Environment (V LE). Keywords should 

be separated by a semi -colon.  

Copyright text:  type some  copyright text to 

display when the activity is  opened and on 

the activity splash screen if required.  

Show copyright in activity:  a check box 

indicati ng whether you want the copyright 

text to  show  on the activity splash screen.  

Request user name:  a checkbox  indicating 

whether you want the user to enter their 

name a t the start of the activity . Their name 

will be included in their report if this option is  

selected. By default this option is checked.  

Cost:  a checkbox  indicating whether this 

activity is a commercially -produced activity 

and has a cost associated with it.  

Protect from edit:  a check box indicating 

whether you want to prevent this activity from being edited  once it has been published.  

Enable score output : a checkbox indicating whether you want to allow this activity to provide a 

score to pass back to a VLE, LMS or other website.  
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Once you have completed the  required information for Activity  Set-Up y ou  can start to create your 

activity ( a sample activity is show n below ). 

4.3. Edit Page  

 

 
 

You create activity pages  in the page editor  by placing interactive and static objects onto the 

page  from the Objects panel.  Some of the objects are specific to a p articular type of activity and 

some are common to all activity types. Each object can contain one or more pieces of content 

(text, image and audio  files) that you source or produce yourself.  You can see which types of 

content can be associated with an obj ect by viewing the icons at the base of the object.  

 

The first thing you need to do is select the type of page you want to create from the Select the 

page type panel .  There are eight types to choose from:  

 

4.3.1. Drag and Drop  

Drag and Drop requires the user  to  match one set of items to another. Objects  can be laid out in 

rows or can be positioned around an image (such as a map or diagram) to become a labelling 

exercise. Red herrings can be added (i.e. dummy drag items ).  
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4.3.2. Sorting  

Sorting requires the user  to sort items into groups or categories . Items and category zones  can be 

laid out in rows or can be positioned transparently over  an image (such as a map or diagram) to 

become a labelling exercise.  

4.3.3. Ordering  

Ordering requires the user to place a number of items  in the correct order by clicking and dragging 

them into place.  This page type can  be used for mathematical or scientific equations, or for 

ordering processes or historical events.  

4.3.4. Fill the Gap  

Fill the Gap requires the user to complete a word, sentence o r paragraph by filling in one or more 

missing words or letters . They can do this either by using a pre -determined  word bank, or by typing 

the a nswer into a text box. A different word bank can be set up for each gap or you can use the 

same word bank for all  gaps .  

4.3.5. Question  

The Question page requires the user to complete a multiple choice question . Questions can have 

multiple correct answers if necessary,  and can be accompanied by an image, audio or video.  The 

user must identify the correct number of answers before clicking the Next button.  

4.3.6. Linking Lines 

Linking Lines presents users with two sets of items. Users link each item in one set with an item in the 

other set using a connecting  line. As with the D rag and Drop  page;  items can be laid out in simple 

rows or can be positioned around an image (such as a map or diagram) to become a labelling 

exercise. Items can have images, audio or text assigned to them.  

4.3.7. Flashcards  

The Flashcards page is intended as a warm -up page  to be used on a whiteboard. It presents a 

series of images which the group  can discuss.  Each image can be assigned some clue text (i.e. first 

letter of a word, or a written clue to prompt discussion). Clicking  the Show answer  button will then 

reveal the correct word/answer. Images can also be accom panied by audio files as required.  

4.3.8. Information  

The Information page is designed to allow you to present a non -interactive page comprising media 

files or some basic information to introduce the activity. The information page can include any 

combination of the main page objects - audio files, images or text boxes.  

4.3.9. Menu page  

The Menu page is designed to allow the user to progress through the activity by choosing their route 

through the pages. You can use it to create an interactive story where the user choose s what 

happens next by clicking one of the options; or you could use it to allow users to concentrate on a 

particular topic within a bigger activity (i.e. choosing triangles within an activity about polygons).  
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Once you have chosen the page type you want t o create , click on its name  to start  editing and 

access  the main editing tools.  

4.4. Editing tools  

4.4.1. Editable page title s 

The activity title  you provided during activity set -up automatically displays on each page, but you 

can change this for each page if you wan t by selecting the title  and typing over it.  

 

There is also an optional page subtitle, which can be changed for each page. If no subtitle is 

added, a subtitle will not be shown in the finished activity.  

4.4.2. Objects panel  

The Objects  panel contains the object s available for you to use in the page 

type you have chosen. Images, text boxes, input boxes, background images 

and pop -ups can be added to all page types. In addition to these, each page 

type has its own specific interactive objects ( see sections 4.7 to 4 .13). 

 

 

 

 

 

4.4.3. Page Options panel  

The Page Options  panel allows you to change the properties and add features 

to the objects and media files, you add to your page, e.g. changing the font 

of text in a text box, resizing an image, etc.  

 

The properties available  in the Page Options  panel will change according to 

the object or media file you currently have selected on the page.  

 

 

 

 

4.4.4. New  button  

Click the New  button when you want to add a new page to your activity . You will see 

the  Select the page type panel and yo u can select a new page type, choose to insert 

a page from another activity or duplicate the page you have just finished creating.  

 

The Insert page from other activity  option will allow you to 

browse for an existing Fuse Creator Ê file and copy a 

page f rom it into your open activity.  
 

The Duplicate current page  option will duplicate the 

page including all the objects and media files you 

added to the page.  
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4.4.5. Labels button  

The Labels  button allows you to view the authoring labels associated with the objects  

you have dragged onto the page. This will allow you to see the order of items or 

matching pairs more easily while editing your activity. Labels will not be shown in the 

finished activity.  

4.4.6. Preview button  

You can preview a page from your activity at any ti me by clicking the Preview  button.  

You will see the page as a user w ill see it.  

 

4.4.7. Add help  

The Add help  button allows you to add instructions / help text to your page to help the 

user complete the activity. The text you add here will display in the activi ty player when 

the user runs the activity.  

 

The user accesses the help by clicking the corresponding Help  button at the bottom of the page.  

4.4.8. Show grid  

Click the Show grid  button  to display a grid on the working page and help you align the 

objects . All obje cts you add  to the working page  will snap to grid  to make positioning 

easier . The grid will not display in the finished activity.  

4.4.9. Recycle bin  

When you want to delete an object from the page, select the object and click the  Recycle 

bin  icon . You can also u se the Delete  key to delete objects.  

4.4.10. Coordinates  

You can view X and Y coordinates in order to position your objects in a specific location on the 

page. You can also view W and H coordinates in order to size your objects to a specific width and 

height. Coo rdinates appear above the page content on the right -hand side.  

4.5. Generic page objects  

4.5.1. Image object  

This object allows you to add an image or a Flash Movie File (.swf) to the page, either as 

supporting information or to form part of your activity.   

 

 

Note :  Any .swf file that you add must be self contained and not access any external files.  

  

 

To add an image to your page:  



 
 

Copyright © 200 9 RM Education plc                                                                                             Page 16 of 47 

 

 

1. In the Objects panel , click on the image icon , hold  the mouse button down and drag the 

Image  object, release the mouse button to drop the  object  onto the page.  

2. The Select File  dialog  box  displays.  

3. By default the Select File  dialog  box will open in the Fuse Creator Media  location .  You can 

choose a different location using the navigation panel  on the left or the Look in  drop -down 

box.   

4. You can choose to open either an image of a .swf file by selecting the appropriate file type  

in the Files of type : drop -down box. When you have selected your file  click Open .   

 

 

Note:  Some images will be larger than the destination image object, if prompted ; you can still 

choose to continue adding the image smaller than actual size or choose a different image.  You 

can resize the image later, ( see below ). 

 

 

You can reposition the image by clicking  and dragging it to a different position.  

 

You can resize  the image box using selection points on the  corners and sides of the object.  

 

The image will be forced into the proportions of the image box in the first instance  but you can 

change this to suit your requirements by using the image options in the Image Op tions panel, which 

displays when you click the image icon  below the object .  

 

Change Image  ð choose this option if you want to change the image  file 

assigned to the object. T he Change image  option will display the Load Image  

pop -up box click Browse  to cho ose another image file  or click Cancel . 

 

Remove  Image ð choose this option if you want to remove  the image  file 

assigned to the object.  

 

Act ua l Size ð choose this option to resize the object to the original size of the 

image.  

 

Keep Aspect  ð tick  this opti on to keep  the original proportions of the image  

whenever you resize the object . 

 

Image flip  ð choose one of the options in the Image flip section to flip the image either vertically or 

horizontally.  

 

Image rotate  ð choose one of the options in the Image r otate section to rotate the image either 

clockwise or counterclockwise.  

 

You can also add images to other generic objects of different types.  To add an image to an 

object, click the image icon  at the base of the object.  

Selection points  

Image icon  
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4.5.2. Background  Image object  

This objec t allows you to add a background image to the page, either as supporting 

information or to form part of your activity.  

 

To add a background image to your page:  

1. In the Objects panel , click on the background image  icon .  

2. The Select File  dialog box  displays.  

3.  By default the Select File  dialog box will open in the Fuse Creator Media  location.  You can 

choose a different location using the navigation panel  on the left or the Look in  drop -down 

box.  When you have selected your file  click Open .  

 

 

Note:  Some ima ges will be larger than the destination image object, if prompted; you can still 

choose to continue or choose a different image.  Large images may make the page run slowly.  

 

 

The image will be forced into the proportions of the ba ckground in the first inst ance, but you can 

resize the image using the  selection points on the  corners and sides of the image . The background 

has a width of 796 pixels and a height of 389 pixels.  

 

Select Background  ð once youõve added a background image, the  Select Background  tab w ill 

become active (located at the top of the page). This is how you select the 

background to make changes to it . If the background is deleted the tab  

becomes inactive.    

 

Deselect Background  ð once a background image has been added and selected, you can lock 

the image to the page by clicking this tab.  

 

4.5.3. Text Box object  

This object allows you to add some text to the page, either as supporting information or 

instructions for your activity.  

 

To add a text object to your page:  

1. In the Objects panel , click on the text box  icon , hold  the mouse button down and drag the 

text object, release the mouse button to drop the object  onto the page.  

2. Double -click inside the text box to type  or click on the text icon  attached to the text object.  

 

To delete the text in the t ext box  at any time without deleting the object itself, first select the text 

and then press the Delete  key.  

 

To delete the text object , click on the object to select it, then, click on the Recycle bin  

icon  or press the Delete  key.  

 

 

 

 

 

 

Text icon  

Selection points  


